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Solved: My Report server installed on , version is I can save report on the server computer,use Power BI Desktop RS.
But I cannot.

When you select the Summary Report, the Grouping tab will also be available. You can Run or Save the
report at any point while creating it. When you click the Run button, the system will prompt you to save the
report. The report is saved temporarily and then a preview of the report is generated. When you click the Save
button, the report is saved in the folder that you specify. To select the report columns In the Create Report
page, click Columns tab. Do the following to select the columns to be displayed in your report: Select the
columns from the Available Columns list box. The columns will be added to the Selected Columns list box.
Use the Up and Down arrow keys to sort the display order of the columns. Select the column name and click
to delete the selected column. Click Run to save the report first, and then run it. Once you have selected the
report columns, click the Grouping tab if you are using Summary Report otherwise click the Columns to Total
tab Refer to Step 5. To group report columns Note: The system will display the column names in the Columns
tab only for those modules that you select here. In the Create Report page, click the Grouping tab. This tab
will be available only when you select Summary Reports under the Report Type tab. In the Grouping page,
you can group the records based on the grouping criteria that you specify. Select the values from the respective
lists. Select Ascending or Descending from the list. To specify advanced sorting filters In the Create Report
page, click the Criteria tab. In the Criteria section, select the additional criteria for the report. Once you have
completed the report customization, do one of the following: Click Run to preview the report. Note, that you
can run the report only after you save it. In the Save Report dialog box, do the following: Enter the Report
Name. Enter the Description of the report. Select the Report Folder in which the report has to be stored.
Availability Profile Permission Required: You can specify a maximum of 25 criteria in a report. To edit
criteria patterns Click the Reports tab. From the list of reports, click the Customize link for the corresponding
report in which you want to edit the criteria pattern. In the Customize Report page, click the Criteria tab.
Review your existing criteria and click the Change Pattern link. In the Pattern Editor box, modify filters and
click the Save link. Save the modified report. You would like to create a report that lists out the deals based on
the following criteria: You can create this criteria easily with the Criteria option as given below: The criteria
pattern will be automatically set as: Since the criteria pattern does not match the requirement, you can edit it
as: You can use the following characters in Criteria Pattern Editor: The operator precedence will not be taken
into account if you do not specify brackets. For example, if you specify the criteria as 1 or 2 and 3, it will be
considered as 1 or 2 and 3 You can change the and or or of the criteria rows and it will be updated in the
Editor below. You can change the and or or condition in the pattern and it will be updated in the rows above.
If you specify 1 and 2 and save it, on editing the report the pattern will be shown as 1 and 2. For 1 and 2 or 3
the pattern will be shown as 1 and 2 or 3 If you add more rows in the editor and delete one by one there will be
additional brackets displayed in the pattern. For example if there are 4 rows added and you delete the 3rd row,
the criteria pattern will be as 1 and 2 or 3. If the first row is deleted then it will be shown as 1 or 2. However,
on saving the criteria, it will change as 1 or 2. Make sure that you do not use the following as they are invalid:
There will be an error message, if the number of rows and the numbers given in the pattern does not match and
also, if there are any missed numbers in the pattern specified. Save and Cancel buttons on the report will be
hidden while editing the criteria pattern. In case the final brackets are missing, there will be a difference in the
Criteria Patterns Editor and its view mode. The information in this field can be used in Reports criteria, to
filter out records that had no activity for a specific period of time or those records that had recent activities.
This option is supported only in the Leads, Accounts, Contacts and Deals modules. These modules should be
selected as the Primary module or should be one of the Related modules. While Last Activity Time under list
view criteria captures all updates made to a record, the Last ModifiedTime will only capture changes made to
the fields and does not include changes made to the Notes, Tasks or Email sections. This criteria can be used
in all types of reports. The activities and updates that will be recorded as Last Activity time: Deleting and
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restoring the records individually or in bulk. Mass operations such as Mass Update, Mass Transfer etc. Except
for the Mass Delete option. Editing contacts or deals under an account will not be listed under the Account.
Deleting related lists under a record. Create Report Folders By default, reports are stored in different
categories. You can create personal or public folders to store the frequently used reports in a common folder
for easy access. In the Create Report Folder page, do the following: Enter the Folder Name. Enter the Folder
Description. All Users are allowed to view this Report Folder: Select if you would like to enable the folder
access for all the users. Show this Report Folder only to me: Select if you would like to enable the folder
access only to you. Allow the following users to view this Report Folder: Select the users or user roles that can
access the folder. To view the report In the Reports Home page, click the required reports group. Click the
Customize link next to the report to customize the report. In the Reports page, you can do the following: Use
this option to save the report with a new name. This option is useful when you filter a specific set of data and
save it for future reference. This feature is used to customize the report with regards to the report types,
columns, grouping, filter criteria in the report, etc. Use this option to update or refresh the contents of the
page. Click Hide Details to hide the details of the report and click Show Details to see the hidden details of the
report. This feature enables you to create charts, such as Bar diagrams, Pie charts, Line charts, Funnel charts
based on the selected report details. Do one of the following, and then click Apply Filter to view reports based
on the filter options specified: Select the option from the adjacent list. Next FQ, for example. On selecting this
option, the system will automatically display the Start and End date in the respective boxes. A maximum of
records will be listed in a page. You can use the navigate options to view others pages. You will be able to
export up to records per page, in each export. Delete Reports Periodically, you may delete some of the
unnecessary reports. Please note that you can delete the reports created only by you. Also, you need to have
the Manage Reports and Dashboards permission in you profile. To delete reports Click the Reports tab. In the
Reports home page, click the Del link corresponding to the report that you want to delete. Edit Standard
Reports You can edit the predefined reports, provided you have the Manage Reports and Dashboards
permission in you profile. To edit reports Click the Reports tab.
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Chapter 2 : Save SSRS Report as pdf using Reporting Services - Stack Overflow
Saving Reports (Report Builder) 03/01/; 3 minutes to read Contributors. In this article. In Report Builder you can save a
paginated report to a Reporting Services report server, SharePoint library, file share where you have write permission,
or your computer.

Contributors In this article In Report Builder you can save a paginated report to a Reporting Services report
server, SharePoint library, file share where you have write permission, or your computer. When you save a
report, what you are really saving is the report definition, which describes the report layout. You are not
saving the data. Every time you run the report, the report data is refreshed and is likely to be different than the
previous time you ran the report. If you want to save the report to a different format or save the report
definition with the data, use one of the following Reporting Services features: Export a rendered report to a
different file format such as comma separated files CSV or Excel workbooks and save the report in that
format. You can also generate data feeds from reports and save the report data. Create report subscriptions to
deliver and save reports to a file share. Use report history to save versions of rendered reports as historical
copies. Saving Reports to a Report Server Saving a report to a report server is also known as publishing a
report. Although you can save reports to your computer, saving reports to a report server offers many
advantages: Reports become available to others who have permission to access the folder in which you saved
the report. Reports can be managed and viewed on the Reporting Services web portal. Report resources such
as data sources, images, and subreports are stored in one place for easier access. Reports can be delivered to
others by subscriptions. Reports are securely stored in the report server database. Report runs can be logged
and provide performance and auditing information. Exporting and Saving Reports If you have a small number
of reports to archive, consider exporting a report and saving it as a file. After you export a report to an
application such as PDF or Excel , you can save it as a file and place it in a protected shared directory on the
network. Alternatively, you can upload a saved PDF or Excel file as a resource item if you want to keep all
copies of a report, regardless of the format, in the report server database. Using File-Share Delivery If you
have a large number of reports to archive, create a subscription that delivers the report directly to the file
system. For this approach, you must create a subscription for each report, choose a shared folder to store the
reports, and define a schedule that determines when the file is created. Once you define a subscription, the
report server can run the report unattended and add report files to the archive using the schedule that you
provide. You can also create single-use schedules if you want to archive reports on an occasional basis. For
more information about subscriptions and file share delivery, see File Share Delivery in Reporting Services.
Using Report History You can also use the report history feature to create historical copies. You can then back
up the report server database and store the backup in a safe location for future use. All report history along
with reports, shared data source items, folders, subscriptions, and shared schedules is stored in the report
server database. You can create a backup to maintain a permanent copy of report history and metadata such as
subscription information that indicates the recipients of a report.
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Chapter 3 : Create, Save, and Share Custom Reports
HELP FILE Create, Save, and Share Custom Reports. Learn how to create, save and share custom reports. Reports
provide detailed information about services, users and customers in a highly-customizable format that can be easily
shared or exported.

How to create a user-mode process dump file in Windows Content provided by Microsoft Applies to: The
Windows Error Report feature does not generate user-mode process dump files. More Information How to
create a user-mode process dump file To create a user-mode process dump file in Windows Vista, use one of
the following methods. To do this, use one of the following methods: Right-click an empty area of the task
bar, and then click Task Manager. Click the Processes tab. Right-click the name of the process that you want,
and then click Create Dump File. If you are prompted for an administrator password or confirmation, type
your password or click Continue. A dump file for the process is created in the following folder: For more
information about how to use the ADPlus tool, click the following article number to view the article in the
Microsoft Knowledge Base: To do this, follow these steps: Click Start , type perfmon in the Start Search box,
and then click perfmon. Expand Monitoring Tools, and then click Performance Monitor. Right-click an empty
area of the display pane, and then click Add Counter. Under Available counters in the Add Counters dialog
box, click the down arrow next to the Process performance object, and then click the Virtual Bytes counter.
Under Instances of selected object, click the name of the process, click Add, and then click OK. The value that
appears is the approximate size of the dump file. When you create a user-mode process dump file, make sure
that sufficient free space is available on the hard disk where the dump file will be stored. References To
collect user-mode dumps Important This section, method, or task contains steps that tell you how to modify
the registry. However, serious problems might occur if you modify the registry incorrectly. Therefore, make
sure that you follow these steps carefully. For added protection, back up the registry before you modify it.
Then, you can restore the registry if a problem occurs. For more information about how to back up and restore
the registry, click the following article number to view the article in the Microsoft Knowledge Base: Enabling
the feature requires administrator privileges. To save these user mode memory dumps locally using Windows
Error Reporting, create the following Registry key:
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Chapter 4 : Create a Power BI report for Power BI Report Server - Power BI | Microsoft Docs
I am using the trial version of the Report Server. The web portal is accessible, but when I try to do a save as to the
report server from the desktop.

If you do not explicitly assign a value to the AutoEventWireup attribute, the default value true is used. If you
are using Visual Studio. There is an important difference between the default value that ASP. NET uses, and
the default value that the Visual Studio. NET template code assigns to this attribute. If the AutoEventWireup
attribute value is set to false, the event handlers that are declared in the. ASPX page do not fire. This may be
confusing if you do not know about this functionality. From the File menu, click Save PageEvent. Right-click
the page, and then click View in Browser to run the page. Notice that the error is thrown and reported
according to the code specifications. Note You may notice that the code issues a call to Server. In addition,
you should also take note of the Inherits attribute in the Page directive. If Inherits is set, you must build the
project before you browse to the page. If you do not build the project first, you receive the following error
message: Add a new file named AppEvent. Add the following code to AppEvent. From the File menu, click
Save AppEvent. Notice that you must add another using statement for the System. Diagnostics namespace to
Global. Add the following code to the Global.
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Chapter 5 : Save RDLC Report as PDF at Run Time in C#
SSRS R2. I have a report with a number of subscriptions saving the report in pdf to a file share. One of the subscriptions
continuisly failes.

Delete a report Create a custom report 1. To make a report only available within a single service, select the
service from the Service drop-down menu. On the Create New Report page, select an attribute e. This can be
any of the following: For example, if you select "Priority level," you can then select "equals," "is less than or
equal to," etc. Click Add Another to add additional attributes and further refine the results included in the
report. Use the Delete icon to remove unneeded attributes. Specify how the results should be displayed e. If
desired, use the Save Report options to do the following: Save report â€” This option is necessary to access the
report later, share the report or use it a dashboard queue Add to Dashboard Queues â€” This option sets the
report as a dashboard queue Share Report â€” This option gives others on the account the ability to use the
report and add it to their own dashboard queues Note: The creator retains the rights to edit shared reports, but
should be aware that any changes made will affect people who use the report as well. Click Run Report to get
results immediately, or Save Report to save the report for later use. The new report then appears under "My
Reports" on the appropriate dashboard. Once saved, the following can be done with custom reports: Access
and edit reports at any time. Email reports to yourself. Edit, close or delete multiple items at once i. Create
email schedules that automatically run reports and email you the results. Create action schedules that performs
actions against all results of the report. Add reports to your Dashboard Queue. Create a new report. Use the
desired check box options at the bottom of the page, as follows: To save the report, ensure that the "Save
Report" check box is selected, then enter a title for the saved report. This will enable you to run it again at a
later time. To share the report with others, ensure that the "Share Report" check box is selected. This will
enable other agents to use the report and add it to their own dashboard queue. Add a report to the dashboard
queue You can add reports to your dashboard queue in either of the following ways: Click and drag the Move
icons in the "Dashboard Queues" section to rearrange the order in which the reports appear in the dashboard.
Edit a report Agents can edit custom and shared reports at any time. Use caution when editing or deleting
shared reports, as they are accessible to everyone and may affect other agents who also use the report. Open a
saved custom report or shared report. Click Run Report to retrieve results without saving, or Save Report to
save changes permanently. Delete a report Note: Once deleted, the data will no longer be accessible within
your account, however, the data remains stored within our system. Agents can delete custom and shared
reports at any time. Please use caution when editing or deleting shared reports, as they are accessible to
everyone and may affect other agents who also use the report. Click OK to confirm.
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Chapter 6 : Saving Reports (Report Builder) | Microsoft Docs
Creating a Macro to Save a Report as PDF in Access by The Office User on Jun, , under Access Another method for
outputting an Access Report to PDF is to create a Macro to do it automatically, whenever the Macro is called.

You create and edit reports in Power BI Desktop, and publish them to the web portal. Then report readers in
your organization can view them in a browser or in a Power BI mobile app on a mobile device. Here are four
quick steps to get you started. You can have both versions of Power BI Desktop on the same computer. In the
Download Center page, select Download. Depending on your computer, select: Select a data source You can
connect to a variety of data sources. Read more about connecting to data sources. From the welcome screen,
select Get Data. Or on the Home tab, select Get Data. Select your data source -- in this example, Analysis
Services. Fill in Server, and optionally, Database. You get to create visuals that illustrate your data. For
example, you could create a funnel chart of customers and group values by yearly income. In Visualizations,
select Funnel chart. Drag the field to be counted to the Values well. Drag the field to group on to the Group
well. Read much more about designing a Power BI report. Now you can view it in the web portal. This link is
a good starting point.
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Chapter 7 : Saving Cognos Reports to the File System â€“ Individual Report Outputs - QueryVision
Create a new text field in User Setup table and add same to Form (Say - Path to Save Report). User based on his
requirement can specify the path where the PDF file should be saved. 2) Create a codeunit which will save report in
PDF.

You would like all the reports to have the same "look and feel", at least on the header and footer sections, and
even include some base queries for items commonly included as parameters for each report. How can you
create such a template and make it appear in the New Project List? Solution Creating a report template is a
several step process. First you need to gather your header and footer requirements, next, you will want to
prepare a list of common parameters to be included in the template. Once the header and footer requirements
and the parameter queries are documented, a basic report can be designed to address the requirements. Last,
you will deploy the template to the appropriate report server template folder on the file system. Gathering
Requirements Requirements gathering remains as one of the most important steps in creating a template. Some
suggestions for the header include: Next, in the process is scoping out the footer area. Some suggested items
for this area include: Additionally, in the body of the report, either at the beginning or end of the report
content, you may set aside an area for displaying extended report parameters or criteria. Your scope process
should also include a default report size and orientation as these items will ultimately impact the placement of
the other objects in the header and footer. One potential idea is to actually use Excel to prototype your initial
template during the design phase; a sample of such a design is displayed below. Next create a new blank
report RDL file. Be sure to add a report header and footer by right clicking anywhere in the white area of the
report and then selecting each of these items as shown in the below figure. Based on your design
specifications, go ahead and size your report and set the report orientation, as noted in the image below, in
order to prepare for the addition of the rest of your design items. Pay very close attention to footer and header
space you use, as these areas occupy this space on each and every page of the report. Also, be sure to use
colors and contrasting colors which are easy to see both online and in print. Next begin adding textboxes for
the different header and footer parts; it is best to add individual text boxes. As you can see from the image
below, the template additions are fairly detailed. Further, notice we insert a thick black line to distinguish
between the header and the body of the report. Of course you could also use a large rectangle object around
the entire header. Next a textbox is added at the bottom of the report body to display any minor criteria for the
report; note this textbox only appears once whereas the page header and footer appear on every page. Finally,
the footer area is defined by inserting several textboxes which contain SSRS built in "global" fields. The next
footer line includes a list of sources. As displayed in the below image, the Built-in fields can be added from
the Built-in Fields list by dragging them directly from the list to the report footer. With all the report template
objects added, we can go ahead and preview the report to be sure it looks as expected. Below are the default or
common locations where the templates are stored. If you changed the default installation directory for SQL
Server, you will need to adjust accordingly. SSRS - C: Upon Selecting New Item, a dialogue box will open,
similar to following image. One important item to note, any changes to an existing template, will need to be
reapplied to any previously completed reports. Next Steps You can enhance your Template even further by
adding a group of standard DataSources, Datasets, and Parameters which apply to all reports. Thus, you will
not have to re-define common queries and their related parameters with each new report. Check out these
related resources:
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Chapter 8 : Unable to Save report to Report Server - Unexpecte - Microsoft Power BI Community
This document is designed to assist users with troubleshooting PDF errors and the ability to Email out of you try to save
a report or invoice as a PDF file to the.

Top of Page Open an existing Power View report When you open reports in a Power Pivot gallery, you can
choose to open the report at a specific view. Click any of the images of the report. The report opens at that
view in reading mode. To edit the report, click Edit Report in the upper-left corner. To open a report in reading
mode, click the report title. The first time you save the report, the default location will be the folder where the
model is located. To save it to a different location, browse to that location, and then click Save. In the Save As
dialog box, in the File name field, enter the name of the file. By default, the Save preview images with report
check box is selected. For privacy reasons you may want to clear it and not save preview images. The report is
saved. You may be able to edit a report, but not have the permissions to save to that SharePoint library or
folder. Thus, you can modify the report in Edit mode as much as you want. However, you can only save your
changes if you also have Add Items permissions for the destination library or folder, or Edit Items permissions
to overwrite the existing document. You can export a report to PowerPoint if you have Open Items
permissions. So if you have only Open Items permissions, you can export a report as is, but not modify it and
then export it. To do that, you need to save your changes first, meaning you need Add Items or Edit Items
permissions. Each view in Power View becomes a separate PowerPoint slide. There are two versions of Power
View: Interacting with Power View reports exported to PowerPoint is similar to interacting with Power View
views in Power View reading and full-screen modes. In PowerPoint slide show and reading view modes, you
can interact with the visualizations and filters that the report creator has added to each view, but you cannot
create visualizations or filters.

Chapter 9 : Saurav Dhyani - NAV & MSDYNBC: Navision Classic - Save Report in PDF File as User Define
There's also a Select programs to exclude from reporting option that you're welcome to explore if you'd rather customize
reporting instead of completely disable it. This is probably more work than you're interested in, but the option is there if
you need it.
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